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Introduction

We are now in version 19 (Photoshop Elements 2021) of Photoshop 
Elements. Adobe has offered yet more wonderful features and improve-
ments to the program.

Before we delve into some of the new features added to Photoshop Elements 2021, 
we want to offer our readers an apology. For several past revisions of this book, 
we avoided some important correction features of the program and replaced them 
with some general information on photography. After looking over some of the 
reviews of our last book on Elements, we noticed a number of readers wanted 
more details related to adjusting brightness, contrast, and color. Therefore, we 
scrubbed the old Chapter 2 related to taking photos and replaced it with the com-
pletely new Chapter 7, in which we cover using the Camera Raw Editor. Again, our 
apologies for the oversight, and we hope this change appeals to those who wanted 
more related to editing photos.

About This Book
This book is an effort to provide as much of a comprehensive view of a wildly 
feature-rich program as we can. Additionally, this book is written for a cross-
platform audience. If you’re a Mac user, you’ll find all you need to work in Ele-
ments 2021 for the Mac, exactly the same as when we refer to using Elements on 
Windows.

In Photoshop Elements 2021, you won’t find a huge number of new features. There 
are a few, but Adobe has again spent much time in this release on improvements 
and on additions to existing features. Adobe offers a few new Guided Edits as well 
as a new creation called Quote Graphic, which we cover in Chapter 17.

New Guided Edits include Moving Photos, which lets you select subjects and 
objects in a photo, move and resize the selection, or duplicate, move, and resize.

The other new Guided Edits include Perfect Landscape, which lets you perfect 
landscape photos, and the Creative Duotone effect, which lets you create true duo-
tone (two-color) images.

There’s also a new creation added in the Create panel. The Quote Graphic item 
enables you to easily add quotes and phrases to images.
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Adobe has included a new option in the Adjust Facial Features dialog box you 
access by choosing Enhance ➪ Adjust Facial Features. The addition is the Face 
Tilt option, which lets you turn faces to face the cameras using some adjustment 
sliders.

Another new feature we’re sure many Elements users will enjoy is a more efficient 
way to back up catalogs. If you have a huge catalog with a lot of photos, Elements 
will take a long time to back up the Organizer. In many cases, you don’t need to 
back up photos; you may want only to back up tags, people, places, and events. 
Now the new Backup Catalog dialog box contains an option for backing up every-
thing except the photos.

Throughout this book, especially in step lists, we point you to menus for keyboard 
commands. For accessing a menu command, you may see something like this:

Choose File ➪ Get Photos ➪ From Files and Folders.

You click the File menu to open its drop-down menu, click the menu command 
labeled Get Photos, and then choose the command From Files and Folders from 
the submenu that appears. It’s that simple.

We also refer to context menus, which jump up at your cursor position and show 
you a menu of options related to whatever you’re doing at the time. To open a 
context menu, just right-click the mouse, or Control-click on a Mac if you don’t 
have a two-button mouse.

When we mention that keys need to be pressed on your keyboard, the text looks 
like this:

Press Alt+Shift+Ctrl+S (Option+Shift+⌘  +S on the Mac).

In this case, you hold down the Alt key on Windows or the Option key on the Mac, 
then the Shift key, then the Control key on Windows or the ⌘   key on the Mac, and 
then press the S key. Then, release all the keys at the same time.

Icons Used in This Book
In the margins throughout this book, you see icons indicating that something is 
important.
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This icon informs you that this item is a new feature in Photoshop Elements 2021.

Pay particular attention when you see the Warning icon. This icon indicates  
possible side-effects or damage to your image that you might encounter when 
performing certain operations in Elements.

This icon is a heads-up for something you may want to commit to memory. Usu-
ally, it tells you about a shortcut for a repetitive task that can save you time.

A Tip tells you about an alternative method for a procedure, giving you a shortcut, 
a work-around, or some other type of helpful information.

Elements is a computer program, after all. No matter how hard we try to simplify 
our explanation of features, we can’t entirely avoid some technical information. 
If a topic is a little on the technical side, we use this icon to alert you that we’re 
moving into a complex subject. You won’t see many of these icons in the book 
because we try our best to give you the details in nontechnical terms.

Beyond the Book
In addition to what you’re reading right now, this product also comes with a free, 
online Cheat Sheet that includes a detailed look at the Elements photo-editing 
workspace, Tool Panel shortcuts, tricks for selecting objects, and more. To get this 
Cheat Sheet, simply go to www.dummies.com and type Photoshop Elements 2021 For 
Dummies Cheat Sheet in the Search box.

Where to Go from Here
Try to spend a little time reading through the chapters in Part 1. After you know 
how to edit and save photos, feel free to jump around and pay special attention to 
the cross-referenced chapters, in case you get stuck on a concept. After exploring 
the Elements Photo Editor, look over Part 2, where we talk about organizing and 
searching photos. When it comes to editing photos, look over Chapter 7 carefully. 

http://www.dummies.com
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Everything begins with adjusting photos for brightness, contrast, and color. In 
Chapter 7, you learn that using the Camera Raw Editor is your first stop when 
editing a photo for any kind of output. If you’re ready to jump into more advanced 
tasks, check out Parts  3 and 4, where you learn how to make selections; layer 
images and effects together; add filters and type; and much, much more.

We hope you have much success and enjoyment in using Adobe Photoshop Ele-
ments 2021, and it’s our sincere wish that the pages ahead provide you with an 
informative and helpful view of the program.



1Getting Started 
with Photoshop 
Elements 2021



IN THIS PART . . .

Open the Photo Editor and make quick and easy edits 
to one of your photos in Quick mode.

Select the best file format when you save your image.

Tour the Photo Editor interface so that you know 
how to switch among images and navigate the many 
panels and options.
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Getting Started with 
Image Editing

Image editing is incredibly fun, especially with a tool like Photoshop Elements, 
which enables you to modify, combine, and even draw your own images to your 
imagination’s content. To get the most out of Elements, you need to understand 

some basic technical concepts, but like most people, you probably want to jump 
in, play around, and basically just get started right away.

You’re in luck: In Quick mode, Elements helps you make basic edits to your photos, 
like revealing your child’s face darkened by a baseball cap’s shadow or cropping 
out the gigantic trash can on the left edge of your otherwise perfect landscape 
shot. In this chapter, we help you jump-start your image-editing skills by guiding 
you through Quick mode and how to share photos online, retrace your steps, save 
your edits, and more.

Getting Familiar with the Home Screen
After installing Elements, launch the Elements application, and you arrive at the 
Home screen (or Hub, as Adobe calls it), shown in Figure 1-1.

Chapter 1

IN THIS CHAPTER

»» Opening the Home screen

»» Starting the Photo Editor

»» Opening, editing, sharing, and 
saving a photo

»» Using Undo History

»» Finding help

»» Saving your files
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From the Home screen, you have the following options:

»» Search (What would you like to do today?): At the top of the window, you 
can search for a task and have help returned to you.

»» Facebook, Twitter, and Help: Click one of the three respective buttons in the 
top-right corner to share files on Facebook and Twitter and to get some help 
using Elements.

»» Try This/What’s New/Guided Edits/Make Creations: The individual cards 
appearing at the top of the Home screen offer options for trying new tasks, 
exploring new features, performing a Guided Edit (Guided Edit is a step- 
by-step set of instructions to perform an edit), and a quick launch to make  
a new creation. When you mouse over a card, a link is shown where you 
perform the task in question.

»» Last Used Version: Below this title, you see Photoshop Elements, Premiere 
Elements, and two drop-down lists. Click a version in the Photoshop Elements 
drop-down list and choose a version. You see some details on what was new 
in the respective version.

»» More: At the right side of the cards along the top of the Home screen, you see 
a right chevron (right arrow). Click the arrow, and the cards scroll right, 
offering more choices. Click several times to scroll through all the cards.

FIGURE 1-1: 
The Photoshop 

Elements 
Home screen.



CHAPTER 1  Getting Started with Image Editing     9

»» Application Launcher: Click one of the three icons to launch the Elements 
Photo Editor, the Organizer, or Video Editor (Adobe Premier Elements must be 
installed to launch this item).

»» Recent Files: Click an image in the Recent Files list, and the file opens in the 
Photo Editor.

Launching the Photo Editor
Photoshop Elements has two separate components:

»» The Organizer is where you manage photos. It’s full of tools for tagging, 
rating, sorting, and finding your images. Part 2 helps you start using the 
Organizer.

»» The Photo Editor is where you correct photos for brightness and color, add 
effects, repair images, and so on.

In this chapter, you work in the Photo Editor to make basic edits to a photo.

Here’s how to start Elements and open the Photo Editor:

1.	 Double-click the Photoshop Elements shortcut on your desktop or in your 
Applications folder (Mac) to launch the Home screen.

2.	 Click the Photo Editor button shown in the Home screen (refer to 
Figure 1-1).

The Photo Editor workspace loads and appears, as shown in Figure 1-2. By 
default, you see the Quick tab selected at the top of the Photo Editor work-
space, which means you’re in Quick mode (or right where you want to be for 
the purposes of this chapter). Quick mode offers a limited number of tools for 
adjusting brightness, contrast, color, and sharpness.

On the right side of the workspace, you see the Adjustments panel docked in an 
area dubbed the Panel Bin. When in any one of the three editing modes (Quick, 
Guided, Expert), you find different panels always on the right side of the window. 
On the left side of the workspace, you see a Tools panel. Interacting with the items 
in the Panel Bin and using tools in the Tools panel provides you with an enormous 
number of options for editing, improving, and stylizing your pictures.
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Making Basic Edits in Quick Mode
For beginning users, the Quick mode in the Photo Editor is both powerful and easy 
to use. Follow these steps to make some simple changes to an image:

1.	 Open the Photo Editor and make sure the Quick tab is selected at the top.

2.	 Choose File ➪ Open.

If Elements is your default editing application, you can also double-click your 
photo file in Windows Explorer or the Mac Finder, and the file opens in Elements.

3.	 In the Open dialog box that appears, navigate your hard drive to locate 
the file you want to open, select the file, and click Open.

4.	 From the View drop-down list (in the upper left of the image window), 
choose Before & After – Horizontal, as shown in Figure 1-3.

5.	 Make edits to your photo.

Here’s an introduction to two simple edits you can make in Quick mode:

•	 Apply a Smart Fix: Click Smart Fix in the Panel Bin to see the options. To 
begin with, click Auto at the bottom of the Smart Fix panel. At the top left of 
the window, you find options for viewing by opening the drop-down menu. 
Choose After Only or choose Before & After (Horizontal or Vertical) to see 
before and after views.

Several items are listed in the Panel Bin below the Smart Fix option, as 
shown in Figure 1-4. Click an item to expand it and move the sliders or click 

FIGURE 1-2: 
The default 

Photo Editor 
workspace 

with the Quick 
tab selected.
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the thumbnail images to tweak the overall brightness, contrast, and color. 
In many cases there isn’t a right or wrong adjustment. Play with the options 
to bring it close to your overall vision for the picture. For a more in-depth 
look at correcting photos in Quick mode, flip to Chapter 10.

Each of the Quick Fix options provides you with thumbnail previews showing 
you the result of a given edit. For a quick preview of an editing task, mouse 
over a Smart Fix thumbnail to see what the edit will look like when it is applied.

•	 Crop the photo: In the Tools panel on the left side of the window, click the 
Crop tool. You immediately see a rectangle on top of the photo. Drag the 
sides to crop the image to your liking. When finished, click the green check 
mark, as shown in Figure 1-4, to accept your edit.

When making any one of a huge number of edits to your pictures, you often 
see icons on top of the image, similar to what’s shown in Figure 1-4. The green 
check mark accepts the edit you’re making at the time the icons appear. The 
circle with a diagonal line is the Cancel button. Click this button when you don’t 
want to apply the recent edit.

At the bottom of the Editor window, you see some hints Elements gives you for 
crop suggestions. Click one of the options to employ the respective crop.

6.	 Choose File ➪ Save As and, in the Save As dialog box that opens, provide a 
new name for the photo. Click Save.

Note: When you use Save As and give your image a new name, you don’t 
destroy your original image. You save a copy of the original with the new edits 
applied. For more on saving files, see the section “Saving Files with Purpose,” 
later in this chapter.

FIGURE 1-3: 
The before and 

after views in 
Quick mode.
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Sharing a Photo
After you edit your photo, you can print the photo to share with family and friends 
or post the photo on a social network site.

In previous versions of Elements, you could upload directly from within Facebook. 
Now, in the latest version, you need to edit the file, save it, and then open your 
Facebook account to upload the file. Here’s how to do it:

1.	 Prepare the photo you want to upload to Facebook.

Typically, digital cameras take photos sized very large — too large for an image 
that your friends and family will want to download quickly and view via 
Facebook on a computer screen or a mobile device. To adjust your image so 
it’s the right size and resolution for viewing online, follow these steps:

(a)	 Choose Image ➪ Resize ➪ Image Size.

(b)	 In the Image Size dialog box that appears, enter your desired width 
(or height).

Either Width or Height is fine because the image will maintain correct proportions 
by choosing either. A width of 720 pixels, 960 pixels, or 2,048 pixels works well.

Facebook recommends that supported sizes for regular photos are widths 
of 720 pixels, 960 pixels, and 2,048 pixels, with file sizes no more than 
100KB — especially if you have text in the cover photo. When you save as 
JPEG, the files are compressed, and you’ll find the larger size to be within 

FIGURE 1-4: 
The Crop tool 

sized on a 
photo.
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Facebook recommendations. However, you don’t have to be too concerned 
about staying within Facebook recommendations. You can upload images 
much larger than 100KB, but the uploads and screen refreshes will take 
longer. Just be certain to stay within 100 pixels if you have text on a 
cover photo.

(c)	 Select the Resample Image check box if for some reason the box is 
not selected.

(d)	 Type either 72 or 144 in the Resolution box.

For screen viewing only, 72 ppi is fine. However, if you want your friends to 
print the image, 144 is a better choice. You can use either resolution. Be 
sure the file size is no larger than 100KB.

The image is sized to a workable size for Facebook. Click OK when finished 
editing in the Image Size dialog box.

2.	 Choose File ➪ Save As ➪ JPEG to save the file as a JPEG.

Note the location where you save the file on your hard drive. (JPEG is one of 
many file formats that Elements supports.)

3.	 Log in to your Facebook account.

4.	 Click Photo/Video.

Locate the saved file and upload it to Facebook.

Your photo is added to your Facebook account, as shown in Figure 1-5.

FIGURE 1-5: 
An edited 

photo 
uploaded to 

Facebook.
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Retracing Your Steps
In Elements, Undo is a favorite command for both beginners and experienced users 
alike. If you don’t like a change to your image, you simply choose Edit ➪ Undo or 
press the keyboard shortcut Ctrl+Z (⌘  +Z on the Mac).

Because the process of trial and error (and thus the ability to undo your work) is 
so important to making your image look just right, Elements also offers ways to 
undo that are much more sophisticated than simply reverting to the last view. In 
the following sections, we introduce you to these more sophisticated tools.

Using the History panel
On the History panel, you see a record of your changes in an editing session. And 
from this record, you can undo your changes from any step in an editing sequence. 
To work with the History panel, you must be in Expert mode. After you click Expert 
at the top of the Photo Editor, here’s how undoing with the History panel works:

1.	 Click Expert in the Photo Editor and 
choose Window ➪ History.

The History panel displays a record of 
each step you made in the current editing 
session, as shown in Figure 1-6.

2.	 To undo one or more edits, click any 
item on the History panel.

Elements reverts your image to that last 
edit. All edits that follow the selected item 
are grayed out.

3.	 If you want to bring back the edits, 
click any grayed-out step on the panel.

Elements reinstates your edits up to that 
level. If you make a new edit after going 
back a few steps, the grayed-out steps 
disappear.

All your steps are listed on the History panel if you remain in Elements and don’t 
close the file. When the file is closed, all history information is lost.

FIGURE 1-6: 
The History panel.
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Storing all this editing history can affect Elements’ performance. If your com-
puter slows to a snail’s pace when you’re using Elements, check out the following 
options:

»» Choose Edit ➪ Clear ➪ Clear History. Elements flushes all the recorded 
history and frees some precious memory, which often enables you to work 
faster. Just be sure you’re okay with losing all the history in the History 
panel thus far.

»» Eliminate Clipboard data from memory. To do so, choose Edit ➪ Clear ➪  
Clipboard Contents or Edit ➪ Clear ➪ All.

»» Restore the number of history states stored to the default of 50. In 
Elements Performance Preferences, you can change the number of history 
states. You can ratchet this number up to 1,000 if you like, but realize that the 
more history states you record, the more memory Elements requires.

Reverting to the last save
While you edit photos in Elements, plan on saving your work regularly. Each time 
you save in an editing session, the History panel preserves the list of edits you 
make until you hit the maximum number or close the file.

If you save, perform more edits, and then want to return to the last saved version 
of your document, Elements provides you with a quick, efficient way to do so. If 
you choose Edit ➪ Revert, Elements eliminates your new edits and takes you back 
to the last time you saved your file.

When you choose Revert, Revert appears in the History panel. You can eliminate 
the Revert command from the History panel by right-clicking (Windows) or Ctrl-
clicking (on a Mac with a one-button mouse) the Revert item and choosing Delete 
from the contextual menu that appears.

Getting a Helping Hand
You probably bought this book because you’re not a fan of sifting through Help 
files and want an expert guide to image editing. We share everything a beginner 
needs to get started in Elements, but Elements is too sophisticated a program to 
cover completely in the pages we have here. You may also need some quick help if 
you don’t have this book nearby.
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Whenever you need a hand, know that you can find valuable help information 
quickly and easily within Elements itself. If you’re stuck on understanding a fea-
ture, ample help documents are only a mouse click away and can help you over-
come some frustrating moments.

Your first stop is the Help menu, where you can find several commands that offer 
information:

»» Photoshop Elements Help: Choose Help ➪ Photoshop Elements Help or 
press the F1 key (Windows) or the Help key (on a Mac with an extended 
keyboard) to open the Elements Help file. You can type a search topic and 
press Enter to display a list of search results.

»» Getting Started: From the Help menu, choose this item for tips and informa-
tion on getting started in Elements.

»» Key Concepts: While you read this book, if we use a term that you don’t 
completely understand, choose Help ➪ Key Concepts. A web page opens in 
your default web browser and provides many web pages with definitions of 
terms and concepts.

»» Support: From the Help menu, this command launches your default web 
browser and takes you to the Adobe website (www.adobe.com), where you 
can find information about Elements, problems reported by users, and some 
work-around methods for getting a job done. You can find additional web-
based help information by clicking Photoshop Elements Online and Online 
Learning Resources. The vast collection of web pages on Adobe’s website 
offers assistance, tips and techniques, and solutions to many problems that 
come with editing images. Be sure to spend some time browsing these web 
pages.

»» Video Tutorials: Choose Help ➪ Video Tutorials to open a web page where 
videos for common tasks are hosted on Adobe’s website.

»» Forum: Choose Help ➪ Forum to explore user comments and questions with 
answers to many common problems.

Tooltips can be another helpful resource. While you move your cursor around tools 
and panels, pause a moment before clicking the mouse. A slight delay in your 
actions produces a tooltip, which is a small box that describes the item your mouse 
is pointing to. Elements provides this sort of dynamic help when you pause the 
cursor before moving to another location.

You can also find help by searching in the Home screen, as mentioned in the  
“Getting Familiar with the Home Screen” section, earlier in this chapter.

http://www.adobe.com

